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Ejercicio 1. Pasos a sequir:

. Crear un servidor Apache Tomcat en Eclipse
2. Crear un Dynamic Web Project

3. Copiar las librerias de Jersey en WebContent/Web-
Inf/Lib

4. Crear un pagquete dentro de JavaResources/src y la
clase Hello dentro del paquete.

5. Crear el archivo web.xml en WebContent/Web-Inf

6. Desplegar el servicio en el servidor (Run as->Run on
Server)

. Probar desde el cliente REST
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1. Creacion de un servidor Tomcat en Eclipse (i)

A ecC I i
(_ I Select a workspace
- Eclipse stores your projects in a folder called a workspace,

Choose a workspace folder to use for this session.

Workspace: Ch\Development\Workspaces\WS5_EclipseMarsI2EE

N
e |

Use this as the default and do not ask again

| ok || cancel |

-

- RECORDATORIO: se recomienda crear una carpeta para el workspace
por ejemplo dentro de la misma carpeta raiz creada para la instalacion
del software (Development)

- Abrimos Eclipse y seleccionamos el workspace donde almacenaremos los
proyectos que se creen.
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1. Creacion de un servidor Tomcat en Eclipse (ii)

Alt+Shift+

EE

Convert Line Delimiters To

Print.

Switch Workspace
Restart

Import.
Export...

Properties

Exit

ject
Enterprise Application Project
Dynamic Web Project

ow
4
=]
anw |8
Crl+Shiftew | 85 EIB Project
L Connector Project
k5| & application Client Project
S StaticWeb rect evelopers
CISTES | M Maven Project
™ Project..
& | Serviet Tutorials
P2 |G Session Bean (B8 3x) Go through tutorials
" E£§ Message-Driven Bean (EJB 3.x)
' Z§ Web Service
Ctrl+P 9 Folder What's New
V| 5 File Find out what is new
M Bample..
4 Other... Ctrl+ N

Alt+Enter

Seguimos las capturas para crear el Servidor Tomcat:
File=> New—> Other-> Server-> Server

Select a wizard

Define a new server

Wizards:

| SEMVEr

4 (= Server

[ Server]
3
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1. Creacion de un servidor Tomcat en Eclipse (iii)

Define a New Server Tomeat Server
Choose the type of server to create Specify the installation directory
Name:
Select the server type: Apache Tomcat v3.0
type filter text Tomcat installation directory:
{5 Tomcat v5.0 Server - C\Development\apache-tomcat-9.0.0.M10 Browse...
P! P
& Tomcatv5.5 Server —
B Tomcat 6.0 Server Download and Install... ‘
& Tomcat v7.0 Server JRE:
{5 Tomcat V8.0 Server
W h I
Bt et [Workbench defautt JRE |[ installed JREs.. |
b 7= Basic
Publishes and runs J2EE and Java EE Web projects and server configurations to a local
Tomcat server.
| Server's host name: 7 localhost
|
Server name: Tomcat v3.0 Server at localhost
@ [ <Back | Neta> |[ Finsh [ Concel | ® v, (errerm— | m—r— | ——

« Seleccionamos Tomcat 9 y le damos a Next

- Seleccionamos el directorio donde hemos instalado el Tomcat y el JRE que
gueremos usar.

- Para el JRE debemos seleccionar el JDK instalado. Habitualmente por
defecto sale seleccionado el JRE, en tal caso sigue los pasos de la
siguiente transparencia.
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1. Creacion de un servidor Tomcat en Eclipse (Iv)

Como seleccionamos el JDK: Pinchar en Installed JRE

- OPCION 1. Si no aparece en la lista el JDK :

Pinchar en Installed JRE-> Add—> Estandar VM > Next

— En la pantalla que sale seleccionar el directorio donde se ha instalado el

JDK 'y Finish

— Ahora nos saldra la pantalla de la opcion 2 (VER y SEGUIR LOS PASOS
DE LA TRASPARENCIA ANTERIOR: seleccionar el IDKy OK'y
seleccionar de nuevo el JDK en el desplegable y Finish).

JRE Type
Select the type of JRE to add to the workspace,

Installed JRE Types:

Execution Environment Description
Standard 1.1x VM
Standard VM

'8; Add JRE | (= e S
JRE Definition JRE Definition
(1) Enter the home directory of the JRE. Specify attributes for a JRE
JRE home: Directory... l JRE home: C:\Program Files\Java\jdk1.8.0_101 Directory... l
JRE name: JRE name: jdk1.8.0_101
Default VM arguments: Variables... Default VM arguments: Variables...

JRE system libraries:

JRE system libraries:

Add External JARs...
Javadoc Location... ‘

[ Source Attachment...
External annotations... ‘

! Remove J

[ 0 Down
Restore Default

@

< Back :I Next » H Finish H Cancel ]

b (3 C:\Program Files\Java\jdk1.8.0_101\jre\lib\resourcesjar
b (a C:\Program Files\Java\jdil.8.0_101\jre\lib\rt.jar B
b ( C:\Program Files\Java\jdil.8.0_101\jre\lib\jsse jar

b (3 C:\Program Files\Java\jdk1.8.0_101\jre\lib\jce jar

b {9 C:\Program Files\Java\jdk1.8.0_101\jre\lib\charsets jar
b ( C:\Program Files\Java\jdk1.8.0_101\jre\lib\jfr jar

b s C:\Program Files\Java\jdk1.8.0_101\jre\lib\ext\access-bi

i s C:\Program Files\Java\jdk1.8.0_101\jre\lib\ext\cldrdata.]
b s C:\Program Files\Java\jdk1.8.0_101\jre\lib\ext\dnsns jar
b s C:\Program Files\Java\jdk1.8.0_101\jre\lib\ext\jaccess.ja

Add External JARs...

[ Source Attachment...J

External annotations...
Remove 1

‘ Up |

b (4 C:\Program Files\Java\jdk1.8.0_101\jre\lib\ext\jfxrt jar Down J
» s C:\Program Files\Java\jdk1.8.0_101\jre\lib\ext\localedat ~
< T | » Restore Default

< Back

[ Net> [ Finish

=

<Back | Net> | [ Finish

©)

[ cancel |
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1. Creacion de un servidor Tomcat en Eclipse (v)

OPCION 2. Si ya estéa aparece en la lista el JDK en Eclipse (si no, ve a la siguiente
transparencia):

— Pinchar en Installed JRE-> Seleccionar el JDK 'y OK.

— Aun dandole a OK es posible que en la siguiente ventana siga seleccionado el
JRE, despliegay elije el JIDK y Finish

8} Preferences.

Installed JREs

Add, remove or edit JRE definitions. By default, the checked JRE is added to the build path of
newly created Java projects.

Installed JREs:

Name Location Apache Tomcat 9.0

| [V] =i, jdk1.8.0_101 (default) C:\Program Files\Java\jdk1.8.... Tomcat installation directory: \
B jdk1.8.0_25 C:\Program Files\Java\jdk1.8.0_... C:\Development\apache-tomcat-9.0.0.M10
B jrel 8.0_45 C\Program Files\Java\jrel.8.0_45

JRE:
| [j8.0.200
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1. Creacion de un servidor Tomcat en Eclipse (v)

Arrancamos el servidor Apache Tomcat:

- En la parte inferior del Eclipse, hacemos click sobre la pestaia Server y ahi
debe aparecer el Tomcat parado (Stopped):

< I | »

m Markers [] Properties &b Servers 2 ﬁ Data Source Explorer [ Snippets ) Console B O EE v O ‘
| Ea Tomcat v8.0 Server at localhost [Stopped, Synchronized]|

- Para arrancarlo, pinchamos sobre él con el botén derecho y seleccionamos
la opcion Start. Dejamos que complete el arranque, cuando haya
terminado aparecerad como Started, Synchronized:

-

<| . ] .

(2] Markers [T] Properties 5 Servers 52 ‘w Data Source Explorer [ Snippets ] Console Q& miE v= 0
} |E Tomcat v8.0 Server at localhost [Started, Synchronized]|

*  NOTA: Para ver la vista de servidores en Eclipse, si no sale por defecto:
Window-> Show View—> Server - Servers.
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2. Creacion de un proyecto web dinamico

File | Edit Mavigate Search Project Run  Window Help Dynamic Web Project =
Mew Alt+Shift+M » g JPA proj ect Create a standalone Dynamic Web project or add it to a new or existing Enterprise Application, Co
Open File... Enterprise Application Project

P P PP Jj
- . Project name: | HelloWorld |
Close Ctrl+W | [ Dynamic Web Project Project location
Close Al Ctrleshiftewy | 8 EIB Project Use defautt location
. e & Connector Project Location: CADevelopmentiwarkspace\HelloWorld Browse...
e r+ [ Application Client Project Target runtime
Save As... . .
L @i  Static Web Project | Apache Tomeatv.0 v| NewRuntime..|
Save All Ctrl+Shift+5 -
- 1% Maven Project Dynamic web module version
= [ Project.. ‘3.1 V|
Move... & Senvet Configuration

# Rename.. F2 [ Session Bean (EJB 3)  Default Configuration for Apache Tomcat v.0 v|[  Modity.. |

Refresh F5 ) A good starting point for working with Apache Tomeat v8.0 runtime. Additional facets can later be
= [§ Message-Driven Bean (EJB 3.x) installed to add new functionality to the project.
Convert Line Delimiters To 3 .
AF Web Service EAR membership
. Add EAR
| Print... Ctr+P | % Folder project to an
. EAR project name: | EAR New Project..
Switch Workspace 3 [T File
Working sets
Restart ™ EBxample.. W e s s
by Import.. [ Other.. Ctrl+N Warking sets: Select...
By  Export..
Properties Alt+Enter
Exit @) < Back Net> | Finsh || Cancel
I

*  Creamos un Dynamic Web Proyect llamado HelloWorld:
— New —>Dynamic Web Project

— Rellenar Project name y sleccionar el Tomcat que acabamos de crear en el
campo Target runtime y - Finish

MUY IMPORTANTE: Respetar mayusculas y minusculas,
especialmente las convenciones de Java para la inicial
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3. Inclusidn de las librerias Jersey

[ Project Explorer 2@] <’=‘=§‘ @ - — 0
4 & HelloWo
b By Deplotor. HelloWorld
[ 28 JAX-WS Web Services
2 Java Resources
[+ =i JavaScript Resources
i (= build
4 (= WebContent
b (= META-INF
4 [ WEB-INF
.
Ej asm-all-repackaged-2.2.0-b14.jar
k& cglib-2.2.0-b14,jar
@ guava-14.0.1jar
k&| hk2-api-2.2.0-b14,jar
k&| hk2-locator-2.2.0-b14,jar
k&| hk2-utils-2.2.0-b 14 jar
@ jackson-annotations-2.2.3.jar
Lt jacksen-core-2.2.3jar

n-databind-2.2.3.jar
n-jaxrs-base-2.2.3jar
n-jaxrs-json-provider-2.2.3.jar
n-module-jaxb-annotations-2.2

jackso
jackso
jackso
jackso

vax.annotation-api-1.2.jar
avaxinject-2.2.0-b14,jar [#1 Markers 2 l i=| Pmperlis| 4 Sewers| & o:
vanservlet-api-3.0.1 jar 0items
varws.rs-api-2.0,jar o "
escription

axb-api-2.2.7 jar
ersey-client,jar
ersey-common,jar
Ersey-con
ersey-container-servlet,jar
ErSEY-SENVERjar

e ) O e O O ) O e O R

e e

tainer-serviet-corejar
ai
rja

(= lib - HelloWorld/WebContent/WEB-INF

»  Copiamos las librerias de Jersey en WebContent/WEB-INF/lib
(previamente las habremos descomprimido)

* Sino aparecen dentro de la carpeta después de pegarlas, refrescar el
proyecto (Botdn derecho sobre el proyecto - Refresh)
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4. Creacion del paquete y de la clase (i)

File Edit MNavigate Search Project Run Window Help
O-EBE& | D E MR

@O0 - @R E-FH D Create @ new Java package.

(5 Project Ex.. 22| = B

Bl -
@
4 & HelloWorld Source folder: | HelloWorld/src
I ‘T;] Deployment Descr
[ A JAX-WS Web Servie MName: | nombrEPaquetEI
1 [% Java Resources . .
N | — Project.. [] Create package-info.java

I &= bu
b e Wi Compare With Class

i [ Servers Interface

Package

Java Package

Creates folders corresponding to packages.

Source Folder

Filter
Listener
Servlet

Example...

Other... Ctrl+M

Creamos un paquete dentro de JavaResources/src llamado
nombrePaquete.

MUY IMPORTANTE: Respetar mayusculas y minusculas,
especialmente las convenciones de Java para la inicial
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4. Creacion del paquete y de la clase (ii)

File Edit Navigate Search Project Run Window Help

O-BE& | ENL R EEEFE O -GG
B S @RI G oD (Quick Access || (5 |[48 Jova EE
[ Project Ex.. 52| = 8 = BlEEox|ET =
Gle ~ P
4 2 HelloWorld An outline is not availa
I3 Deploym: 5
L s, [ [ New v Project..
4 2% Java Resol 2l @ Annotation
4 BSE; Open Type Hierarchy @ Clas
no )
»
s T Showin AlteShiftsW b | & Enum
b il JavaScript [ Copy craec |G |Interface
b build s cony Qualified Name & Package
o & WebCont o, CtrlV HTML Fil
A L w51 e
MK Delete Delete | & ISP File
# | Remove from Context Ctrl+Alt+Shift+Down | + .
T8 Filter
Build Path | 48 | Listener
Source ARSI b | o oy
Refactor Al ShiftsT ¥
9 Example..
fa Import..
T — [ Other.. Ctrl+N
[ |
g
aell | Refesly | g | S &
Profile As » P
Debug As v
Run As v | Resource Psth
Validate
Team »
Compare With v
< Restore from Local History...
£ nombrePaquete Properties Alt+Enter

=

LH

Java Class

Create a new Java class.

e

Scurce folder: ‘ HelloWorld/src | | Browse... |
Package: ‘ nombrePaquete ‘ | Browse... |
[]Enclosing type: Browse...
Name: [ Hello| |
Modifiers: (®) public (Opackage private () protected
[]abstract [ ]final [ static
Superclass: ‘ javalang.Object | | Browse... |
Interfaces: Add...
Remove
Which method stubs would you like to create?
[] public static void main(String[] args)
[C] Constructors frem superclass
Inherited abstract methods
Do you want te add comments? (Configure templates and default value here)
[ Generate comments
@ Finsh || cCancel

Creamos la clase Hello e introducimos el codigo de la siguiente
transparencia.

MUY IMPORTANTE: Respetar mayusculas y minusculas,

especialmente las convenciones de Java para la inicial
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4. Creacion del paquete y de la clase (iii)

- ®@N 2 RSERF -0 R G- -+ -0 3
[3] Hello java S@l

package nombrePaquete; : package nombrepaquete;

2

3= import javax.ws.rs.GET;
4 dmport javax.ws.rs.Pathj
5 dimport javax.ws.rs.Produces;

6 import javax.ws.rs.core.MediaType;

import Jjavax.ws.rs.GET; . e e ¢

9 public cla
18
115 @GET

import javax . ws . rs . Path; 12 (@Produces(MediaType. TEXT_PLAIN)

13 public String sayPlainTextHello(){return "Helle Plain";}

14
15

import javax.ws.rs.Produces;

import javax.ws.rs.core.MediaType;

@Path ("/hello")
public class Hello {

QGET

@Produces (MediaType.TEXT PLAIN)
public String sayPlainTextHello() {return "Hello Plain";}

}

NOTA: No olvidéis salvar el archivo tras pegar o modificar el cédigo.
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5. Creacion del archivo web.xml (i)

o omcom L a

" "

]
File Edit Source Refactor Navigate Search Project Run Window Help E webaxml £3 E
B-Ho& P S EN w |00 File : N S

= E £ X l Wers
H-Q-Q-F-E- 2SS -@RY - O Create a new file resource. :_ -
CHET 2= <web-app >
= S = = 3
(& Project Ex.. I = H ) Helllojava 52 1 = Hgt 0% I 8 T| Enter or select the parent folder: 4 -
ok ; = gservlets
‘ gHE‘W;z‘ New | s | HelloWorld/WebContent/WEB-INF
H Golnto 5 | Fie \ 5 <servlet
b & Deploy B oD
b A Wy  Showln Alt-ShifteW b | (5 Folder s G sservlet
4 22 Java Re B soLFie 4 & Helloworld _
4 G sic Copy Gt (= settings Fi=} <]
. @ { B2 Copy Qualfied Name &Y HTML File b o build
| Paste Cul+V | [$ ISPFile b B sic 8
> = Libi) 3¢ | Delete Delete | = Eample... 4 (= WebContent e
b B JavaSer o peove from Context Ctrl+ Alt+ Shift+ Down = META-INF 18
I (= build Build Path b rﬁ Other... Ctrl+N
4 (= WebCo o b = WEB-INF 11 p
b = MET Moess = RemoteSystemsTempFiles !
‘EE (R & > Servers 12 <fservlet:
[ -
b @ Servers |1 Import-. 13= <zervlet-n
(& et 14 <servle
&) Refresh F5 .
15 <url-pz
Validate b
St P e T = = File name: | web.xml 16 </servlet-
urce Explo... )
Profile As » = 17 </web-app:
Run As * | Resource Path
Team 3
Compare With » Fl |
Restore from Local History...
< source » @ Finish | | Cancel Design | Source
[ WEB-INF - Hell ) \
Properties Al Enter

«  Creamos el archivo webh.xml en WebContent/WEB-INF

- Se abre automaticamente con el editor XML. Pinchar en la pestafa inferior
“Source”, para verlo en modo texto

Copiamos en él cddigo de la siguiente transparencia y salvamos.
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5. Creacion del archivo web.xml (i)

<?xml version="1.0" encoding="UTF-8"?>
<web-app xmlns:xsi="http://www.w3.0rqg/2001/XMLSchema-instance"
xmlns="http://java.sun.com/xml/ns/javaee"”
xmlns:web="http://java.sun.com/xml/ns/javaee/web-app 2 5.xsd"
xsi:schemaLocation="http://java.sun.com/xml/ns/javaee
http://java.sun.com/xml/ns/javaee/web-app 3 0.xsd" id="WebApp ID" version="3.0">

<servlet>
<servlet-name>Mi Servicio Hello REST</servlet-name>
<servlet-class>org.glassfish.jersey.servlet.ServletContainer</servlet-class>
<init-param>
<param-name>jersey.config.server.provider.packages</param-name>
<param-value>
nombrePaquete, com. fasterxml. jackson.jaxrs.json</param-value>
</init-param> Eﬂﬁﬁmwwm B - °

</servlet>

b pp ml ="http:. //www w3 or g/zoaz/ms chema-instance” xmlns="http://java. sun.com/x

28
3

P

5 <serviet- mm Hello nst</

6 rletocia org.glassfish.jersey.s cerile t s ervlstconta er</serviet-class>
7

8

nerjersey.config.server.provider. packages</paran-name>

<servlet-mapping>

, com. fasterxml. jackson. jaxrs. jsonc/param-value>

<servlet-name>Mi Servicio Hello REST</servlet-name

<url-pattern>/demo/*</url-pattern> o™ 7
</servlet-mapping>
</web-app>
NOTA: dependlendo del S|stema operativo las comillas puede que se copien mal.
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6. Despliegue del servicio en el servidor

Desplegamos en el servidor Tomcat %‘J e == e
que hemos creado anteriormente: 21 o N & s
Boton derecho sobre el proyecto - e N i
Run as = Run on Server = Elegimos | | @ s
el servidor creado =>Finish e

- Preguntara si queremos reiniciar el e ) —
servidor, le damos a OK DEE

- Sitodo ha ido bien al desplegar el = A
contenido del servidor, saldra debajo [ o v
el servicio sincronizado. \ - -

. . (%[ Markers [7] Properties &4 Servers 5% [} Data Source Explorer [ Snippets B Console

‘ SI no hab“,a que pInChar en Ia peStaﬁa 4 ETomcatv&OServeratlocalhost [Started, Synchronized]
de la consola para ver el error. B heboaild Isynchionig]

* No hay gue preocuparse si en el | © ® $ httpi/flocalhost8080/HelloWorld/

navegador de Eclipse sale Error 404\

 NOTA: Para ver la ventana de
(792 Informe de estado
consola, problemas o log de errores: e jucioworas
Window-> Show View—> General-> |a == el recurso requerio no estd disponible.

opcién correspondiente
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7. Probar desde el cliente REST

Pre-request Script Tests Cookies Code

En la request url de Postman ponemos la siguiente URI:
, seleccionamos GET y
pulsamos sobre Send. Nos deberia dar el resultado siguiente:

*  La URI se ha formado con la direccion del servidor Tomcat
(localhost:8080), el nombre del proyecto (HelloWorld), el nombre de la raiz
gue establecimos en el archivo web.xml (demo) y el nombre del path

indicado en la clase (hello).


http://localhost:8080/HelloWorld/demo/hello

Anexo 1

Como evitar el mensaje de error al desplegar

+ Debes tener en cuenta que este error no es relevante
ya que trata de cargar una web “en parte de cliente”, a
pesar de tratarse de un servicio.

* En cualquier caso, si ho quieres que aparezca este
error:

1. Dentro de la carpeta Webcontent del Proyecto anade
un archivo Index.html con el texto que quieres que
aparezca en la web.

2. Dentro del web.xml antes de cerrar la etiqueta
webapp anade lo siguiente:

<welcome-file-1list>
<welcome-file>Index.html</welcome-file>

</welcome-file-list>




